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What’s New in RAM Commander version 8.0
This document describes new features of RAM Commander 8.0. The document covers only the features which were added to the RAM Commander 8.0 since 7.7 version. Please, see RAMC_7_70_Release Notes and previous documents for earlier versions features additions.
Major Improvements and New Features

 New Look

 MSG-3 module
 Reports generation in MS Word template

 FTA Enhancement

 Component Library Import Improvement
General
 Publish any RAMC report to MS Word using template
 Russian added to the RAM Commander build-in spelling checker
 Projects List – hierarchical projects view

 Updated User Manual

Reliability

 Updated Component Library

 RBD - Monte-Carlo – Addition of confidence levels (50%, 60%, 70% etc.)
FMECA
 FMECA Import/Export - include phases library, severities and safety severities
 FMECA Export/Import - export EE data per phase
 FMECA - Get sum of Alphas for FM
FTA
 Improved MCS calculation speed
 FTA batch calculation
 Calculate Unreliability F(t)
 Calculate Frequency W(t) and Intensity L(t)

 Calculate Number of Failures E(0,t)

 Export of FTA diagrams (tree with sub-trees) to MS Word
 Allow changing diagram node size
 Change Basic Event Code in Library (and all occurrences in trees)
 More exact calculation using first/second order approximation

 New basic event calculation model - Latent

 FTA Configuration Control Report
 Special Global Change functions

 FTA – gates list report – includes gates of subtrees

 FTA - optionally control formatting of Qm,Qt probabilities on tree image
 Tree gates report, Basic events report – output by MS Word template

 MCS View - show additional event data, MCS filtering

 FTA Appendix for FHA Report using MS Word template
Safety
 FHA, SSA, SARS, AFO reports by MS Word template

 Import/Export safety data to and from Excel

 Failure description, Actions, Verification and other fields length is increased

 1 average flight hour probability calculation in FTA and Safety reports
 New report - Basic Events for specified Safety Severity

 AFO report ( required by Russian AR MAC ) - show phases/severities even if no FTA is selected
 FMECA/Safety Library - Set default Objective Probabilities
MMEL

 Single project may contain different MMELs for JAA and RRJ standards
 MMEL 5 column report - by MS Word Template
FMEA
 Standard FMEA report using MS Word template

 FMEA team work – possibility to rank Severity for FM without causes
Other
 Backup 8.0 project as 7.7 project

 Login screen wrong look on DPI<>96 - fixed

 English spell checker improved, case-sensitivity problem solved

 RAM Commander is tested for and is compatible with Windows Vista and Windows 7 – for both 32-bit and 64-bit processors.
 FTA - "Transfer branch to subtree" operation – bugs fixed
 GPRD – copy FR table to another environment – bug fixed

 Import Wizard – large BOM import fixes & progress indication
 Siemens SN 29500 fixes in library data import and translation

Installation of RAMC 8.0
For the local stand-alone installation, run the RAMCW80.EXE downloaded from the A.L.D. web site (www.aldservice.com), or run RAMC\setup.exe from the installation CD. For additional instructions and for client-server configuration, see User Manual - Installation Guide (Getting Started Chapter). 

RAM Commander version 8.0 Release Notes
Major Improvements and New Features
New Look
RAM Commander User Interface was improved:
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The software look change is optional. Users prefering the traditional RAM Commander look or users (especially those working with Windows Vista or Windows 7) who prefer RAM Commander look to be consistent with selected Windows "skin" may switch the new look off by removing comments from the line " //Skin=NONE" in RAMC32/BIN/ramc.ini file.

Advanced users may also select another look by providing MS Windows "skin" file ("*.msstyles") – put the file to RAMC32/LIB folder and set Skin parameter in RAMC32/BIN/ramc.ini file to skin file name.
MSG-3 module

New RAM Commander module is used by aircraft manufacturers or aircraft operators (airlines) to perform aircraft Scheduled Maintenance Development analysis according to Air Transport Association (ATA) MSG-3 document. 
The MSG-3 module is integrated with RAM Commander basic, Reliability and FMECA modules. It divides the procedure into 7 steps including system definition, maintenance significant items selection, failure effect categorization, task selection and development and report generation:
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Module uses intuitive interactive decision diagrams, the same as used in the original MSG-3 document:
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As an output of the procedure user gets final report generated in MS-Word with all the data inside. Report is generated based on customizable MS Word template; user may change the template design.
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Reports generation by MS Word template
New tool for report generation directly to MS Word was added to RAM Commander. Reports are generated based on RAM Commander project data and MS Word report template. New reports were provided for FTA, Safety, MMEL and Safety modules. 

When new MS Word report is launched from RAM Commander menu, available report templates list will appear:
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Select the template from the list and press "Select" button to proceed to the report generation.

User may also add his own templates. To create user-defined template:

1. Choose template which is close to your required report

2. Find the template file it in RAMC32/LIB folder

3. Copy the template file to another file name in the same directory LIB. 

4. Open the newly created file in MS Word and perform the required changes in document design.

5. Save the template.

6. Return to RAM Commander, "MS Word Template Selection" dialog.

7. Press "Add" button, select the newly created template and provide description.

8. Template will appear in templates list and may be used for report generation.

When "Select" button is pressed, RAM Commander will launch report generation. During the generation do not work with MS Word or other MS Office applications (Excel, PoerPoint etc.)

The generated report will appear on the screen:
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See report details below in particular module new features.

Component Library Import Improvement 

Component Library import from MS Excel file is now available (in addition to standard ASCII file import).
RAM Commander 8.0 package contains formatted Excel template for electronic components data input (RAM Commander Installation folder, LIB subfolder, CompLibImport.xls file). The template contains separate sheets for each electronic component type (IC Digital, Resistor, Capacitor etc.) with type-specific fields on each sheet. All relevant fields have lookup libraries (drop-down lists with all possible data values appear in these fields):
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Such libraries lookup fields contain both general description (like UVEPROM, TTL etc.) and RAM Commander internal code (1,2,3 etc.) required for import, it may be used to create automatic data conversion routines from customer-specific components database to RAM Commander import file. Such conversion routine may be created inside the supplied CompLibImport.xls file – using VB for applications or lookup fields/formulas – see sheet "ConversionExample" of the excel file:
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When the data transformation/input in the excel file is finished, switch to the first sheet (named "_Main") and follow instructions. Intermediary text file will be created; this text file should be used in RAM Commander Component Library data import:
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This new feature should be much more convenient, user-friendly and less time-consuming than ASCII file preparation in specific format required by previous RAM Commander version.

General
Publish any RAMC report to MS Word using template

Any RAM Commander report now may be exported to MS Word with addition of standard page headers and footers. Export to MS Word is performed using template documents which are user-defined.

To export report to MS Word using this new feature:

1. Open usual RAM Commander report (in HTML mode)

2. Select "Publish with MS Word Template" in Report menu:
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3. Document parameters dialog will appear – provide information which will appear in report header and footer:
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4. Templates list will appear. Select template and press Select button.

5. The same report will appear inside the templated document with required headers and footers:
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Russian dictionary in build-in spelling checker
Built-in spelling checker now supports Russian language. To use it:

1. Select "Spell Checker Dictionary" from the Tools menu in product tree screen (or FTA, Safety, FMECA, RBD, ETA, FMEA).

2. File selection dialog will appear.

3. Select "SpellRU.lex" file in the RAMC32/BIN folder and press ok.
When the spelling checker is configured, press "Ctrl+S" buttons in edit field or table cell to perform the spelling check.
Projects List – hierarchical projects view
Projects list now may be displayed in a hierarchical tree style, where projects are grouped by project groups:
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Each project has a setting called "Project Group". Project group may be anything that unifies different projects of the same product, customer, year, version etc. Hierarchical projects view puts each project group to the separate tree branch, providing more convinient operations with multiple projects from different products.

Select "Tree View" option from the View menu in Projects List window to use this option.
Updated User Manual

RAM Commander User Manual was revised and updated, new chapters (MMEL, Safety, Event Tree Analysis, MSG-3) were added. The updated user manual is available on RAM Commander CD or you may download it from ALD Software Downloads web site.

Reliability

Updated Component Library

New analog device components added – component library size is now 64,500 components.
RBD - Monte-Carlo - Add confidence levels (50%, 60%, 70% etc.)
New confidentce levels are available in Monte-Carlo configuration of RBD module:
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FMECA
FMECA Import/Export - include phases library, severities and safety severities

FMECA Import and Export to and from Excel now includes also additional libraries - Phases, Severities and Safety Severities with all information stored there. Each library appears on a separate Excel sheet. Each of these libraries may be imported separately.

FMECA Export/Import - export EE data per phase

FMECA Import and Export to and from Excel now includes phase-specific information for End Effects. End Effects may have different severity, safety severity and objective probabilities for different phases. Tis information is exported to (and imported from) MS Excel files separate sheet named "EE_SAF" with the following structure:
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Each End Effect (EE_name field) appears multiple times, each time in conjunction with different phase (Ph_name field), and each line contains information for specified EE in specified phase.

FMECA - Get sum of Alphas for FM

Right-click the "Alpha" column in FMECA data table, then select "Sum Alpha" option to get total sum of all alphas for the current tree item:
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FTA

Improved MCS calculation speed
Our MCS calculation algorithm has been significantly improved, providing for a  dramatic improvement in FTA calculation speed – up to 40 times faster for large FTAs.

FTA batch calculation
User may run calculation of multiple fault trees at once. To use this option, choose "Batch processing" from the "Calculation" menu in FTA module and select the desired option:
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Then the FTA list will be displayed – select multiple trees to be processed (using Ctrl and Shift buttons) and press "Ok". Operation will be performed for all selected trees and processing log will be displayed.
Calculate Unreliability F(t), Frequency W(t), Intensity L(t), Number of Failures E(0,t)

Calculation of new parameters is available:

	Name
	Symbol
	Description

	Unreliability
	F(t)
	Unreliability for time t – probability of system failure over specified period of time.

	Frequency
	W(t)
	Frequency (unconditional failure intensity) at time t - an expected amount of failures per untit time at time t.

	Intensity
	L(t)
	Intensity (conditional failure intensity) at time t.

	Number of Failures
	E(0,t)
	Number of times the system is expected to fail in time period from 0 to time t.


The calculation is available from "Reports" menu, "Unavailability Curve" option of FTA module. The report definitions dialog will be displayed:
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Select the desired parameter and report options (time, number of points, results presentation form-report or graph) and press Ok to see the results:
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Export of FTA diagrams (tree with sub-trees) to MS Word
Tree and all its subtrees may be exported to a single MS Word document using template.

Select "Export to file->Export tree + subtrees to MS Word" option from "FTA Diagram" menu:
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List of available MS Word templates will appear. There are two templates provided, user may add additional templates. Choose one of the templates and press Ok. RAM Commander will create and open an MS Word document with all fault trees in it:
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Allow changing diagram node size
Diagram node (large boxes with text) size may be changed for each diagram. Open the FTA properties dialog (double-click an empty space on diagram or use "FTA Diagram"->Properties menu), change Node box heigth and width values and press Ok. TA will be rebuilt according to new sizes (previous visual attributes of FTA elements - location, color etc. - will be lost):
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Change Basic Event Code in Library (and all occurrences in trees)
It is now possible to change Basic Event code in the library. All occurrences of this particular bacis event in all trees in the current project will be also updated.
More exact calculation using first/second order approximation 

RAM Commander 7.7 supports first/second order approximation of the results in addition to Easary-Prochan formula. It gives more exact calculations but slows down the calculation speed. User may select approximation type from 3 types available:
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	Type
	Explanation

	Automatic
	The best type will be selected by RAM Commander. In most cases it Easary-Prochan will be selected, except cases when there are XOR or NOT operations in the fault tree

	Easary-Prochan
	Easary-Prochan formula

	F1:F2
	First/second order approximation


New basic event calculation model – Latent
New Latent basic events calculation model is available. It is used when we have components with failure rate which are tested periodically and which failure will not be detected until the test is performed. Two input parameters are required – FR and test interval Ti.

The display symbol of such event is two nested circles, probability calculation is performed using formula Q(t) = 1-(1-q)*exp(-FR*Ti), where Ti is test interval.
FTA Configuration Control Report
New report is a tool to check the consitency of all fault trees in the project and get indication of possible calculation problems, absent data, wrong tree structure etc.
Select "FTA Configuration Control Report" from the Reports menu.
Special Global Change functions
Several possibilities to perform global FTA data changes were added:

· Automatically compose basic events description using pattern

· Automatically change basic event codes using pattern

· Automatically change Gate codes for all trees using pattern

· Change MCS, Time and node size paramaters for all trees in project

· Replace all occurrences of one basic event to another basic event in all trees

New functions are available from the Tools menu, "Global Change" submenu in FTA module. Use these functions carefuly and make project backup before using them.
FTA – gates list report – includes gates of subtrees
FTA Gates report now includes also gates of all subtrees of the selected tree.

FTA - optionally control formatting of Qm,Qt probabilities on tree image

Tree gates report, Basic events report – output by MS Word template
Tree gates report and basic events report now available in MS Word format and are generated by customizable MS Word template.

MCS View - show additional event data, MCS filtering
FTA calculation results dialog can display additional information about basic events and may display only minimal cut sets satisfying selected condition.
To display additional event data (element type, event calculation type) select corresponding check boxes in the settings pane and press the refresh button:
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To set MCS filter press "Filter" button and select conditions, then press Ok:

[image: image29.png]Display orly cut sets containing at east one event which saisy the selected
conditon

any one o selected gate ypes AND any ane of selected event types)

Gate ypes: Event ypes:

obabily
Frequency





FTA Appendix for FHA Report using MS Word template

The new report provides details for all fault trees used linked to Safety module failure conditions for their probability calculation. Choose "FHA Appendix" report from the Reports list. 
Report is generated using customizable MS Word template.

Safety

FHA, SSA, SARS, AFO reports by MS Word template
Main Safety module reports now may be generated using MS Word templates. Choose "Report by MS Word Template" option from "Reports" menu, select desired template and press Select:
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Import/Export safety data to and from Excel
All Safety Module data may now be imported or exported from/to MS Excel. Use Import and Export options in the Tools menu.

To import data obtained from other system to RAM Commander module, the data should be converted to RAM Commander format. Perform Safety data Export on an empty project to get MS Excel file template, then insert the data into this template.

The Excel file contains following sheets:

	Sheet name
	Description

	Functions
	List of all functions (Function, Description, ParentFunction)

	Failures
	List of all failures linked to functions (Function, Failure, Parent Failure, Phases, EndEffect, Severity, Verification, …)

	PHASE
	FMECA phases library

	SAF_SEV
	Safety Severities library

	EE_SAF
	End Effects data per phase (severity, safety severity, objective probabilities)


Failure description, Actions, Verification and other fields length is increased
Listed Safety fields' capacity in the new version is not limited (old version's limit was 200 characters).

1 average flight hour probability calculation in FTA and Safety reports
One flight hour calculation in Safety reports is fixed, now it is Failure probability for flight phase / flight phase duration. 
New report - Basic Events for specified Safety Severity
The new report (it may be found in Reports menu of the Safety module) displays all Basic Events which participate in Fault Trees which in turn are linked to Failure Conditions leading to End Effect with specified Severity.
AFO report - show phases/severities even if no FTA is selected
AFO report now displays phases and severitis for failure condition event if this failure condition doesn't have linked probability calculation mean (FTA):
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FMECA/Safety Library - Set default Objective Probabilities
FMECA library has default objective probabilities for each Safety Severity in Safety Severities list:
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FMECA library has also particuar objective probabilities for ech End Effect and Phase in End Effects List:
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The new option (button "Set Default Probabilities" under the End Effects list) allows setting all probabilities in EE list according to default probabilities in Safety Severities list.
MMEL

Single project may contain different MMELs for JAA and RRJ standards

There are several MMEL standards supported by RAM Commander – JAA and RRJ. Single RAM Commander project may contain parallel MMEL databases for each one of these standards, one analysis data is not interfering with another standard. To select the required standard and switch between them, open project configuration dialog (Project->Configuration menu from Product Tree scren) and select the standard from the list:
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The selected standard is displayed also on MMEL screen.

MMEL 5 column report - by MS Word Template

MMEL 5 column report is now available in MS Word format and is generated using customizable template. Choose "Five column (MS Word)" report subtype for MMEL report in standard FMECA reports list:
[image: image35.png]Tope: [MEL -

Subtype: | Five Column (M Word) -

Canddate Lt
Five Columry

Phase:





FMEA

Standard FMEA report using MS Word template
Standard FMEA report is now available in MS Word format and is generated using customizable template. Choose "FMEA Stadard – MS Word template" reprot from the list of all FMEA reports, choose template and press the "Select" button:
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FMEA team work – possibility to rank Severity for FM without causes
FMEA team work feature now allows setting Severity ranks by group members even when the corresponding Failure Mode has no Causes defined.
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